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SETTING UP THE CD

To view the CD install the free Adobe Reader provided in the CD
folder named Adobe Reader. Most computers come with an Adobe
reader. You may also download and install the latest reader for free
from www.adobe.com. If you wish to view the video files, also down-
load and install the Adobe Flash-player. This is also on the CD. If you
use Google’s Chrome browser, then you already have the Flash-player.
The CD will work without the Flash-player

 Fig. 3: 1:~Downloading Adobe Reader XI and Flash-player
http://www.adobe.com/africa/products/reader.html and http://get.adobe.com/flashplayer/

Installation of 
the Reader

To install the Adobe Reader double click the appropriate executable
file (with an .exe extension). An installation wizard should guide you
through the installation process. This may take 5 minutes or so.

Viewing and sav-
ing to your hard 

drive

Once you have installed the Adobe Reader on your hard drive, choose
File > Open or click the Open button on the toolbar and select the file
“Diaspora.pdf ” on the CD (or any other .pdf file that you want to
view). Once you have loaded the CD, copy it to your hard drive using
the “Save as” command. The CD is not copy protected. Moving
around Diaspora will be much faster when the file Diaspora.pdf is on
your hard drive. 
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Select the mag-
nification

Select the magnification that you are comfortable with by choosing View
> Zoom to and select a percentage/Actual size/Fit Page/Fit Width options.
You can also use the magnification options that are available on the tool-
bar which may be customised. With this version of Diaspora, you will be
best served with the Full Screen Option <CTRL>L. Use <ESC> to exit
the full screen option.

 Fig. 3: 2:~The full screen option

Searching the 
CD 

Select the Search button from the edit menu on the toolbar. A window
will open with an input box at the top where you can type in the word or
phrase you want to search for. For example, you might have come across
the term “matres”. So you type in “matres”. This will look for all occur-
rences of the word, lower case, italic, bold et cetera. You should find the
explanation of the term in the glossary, but you will also find all occur-
rences of the word in lists and articles in their context.
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 Fig. 3: 3:~Using the advanced search function

Index entries are 
clickable

All of the indexes are clickable. Other options like “Whole words only,”
“Case-Sensitive” are also available. Click the Search button to start the
search. The search takes some time.

Select text The Select Text tool enables you to select text or columns of text in a
document. You can use the Copy and Paste commands to copy the
selected text into another application. Select text by dragging from an
insertion point to an end point or by dragging diagonally over text. 

Printing To print the document or pages within the document the following pro-
cedure can be used: Select the text you wish to print and copy this and
paste special to your word-processor such as Notebook, Word or Word-
pad.

1. Change the pasted font to black. This will get rid of the black back-
ground. 

2. Click the Print button, or choose File > Print.

3. Choose one of your printers from the list at the top of the Print dia-
logue box.

VideosYou might also like to view the Lodge in a video

On the CD, go to Contents: List of videos. Click on the video you wish
to view. “Click here to activate...” means a micro or flash movie is embed-
ded. Click on the message to run the video and/or music. You can leave
the video at any point. No need to rewind.
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 Fig. 3: 4:~Videos will only activate if you have adobe Flash-player installed
see page 1 for the URL.
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INTRODUCTION TO E-BOOKS

A new type of 
history

One purpose of this E-book is to encourage a change in the way his-
tory is researched, read and written. For too long history has been
written by trained historians employed by universities and funded by
large granting institutions. Such history is often of such a demanding
and esoteric nature that the subjects of the history do not recognise
themselves. Consequently, such books are neither sold nor read in the
subject communities. Such books are also expensive. The people are
thereby cheated of their own past and, therefore, of their identity.

Symbols and 
sources 

A primary source is defined as an eyewitness account, where the
writer, observer or oral informant was present. A secondary source, on
the other hand, is usually an interpretation of primary sources. This E-
book contains many hundreds of primary sources, the building blocks
of all history. The CD also contains many secondary interpretations of
the Lodge. I have tried to draw the reader’s attention to primary
sources (left symbol) and secondary sources (right symbol):~

 Fig. 1: 1:~Primary and secondary symbols used in CD

Few limitations 
of the new his-

tory format

The E-book has few limitations regarding colour reproduction,
length, or indexing capabilities. The CD format allows for much
longer documents than the book format. CD’s are also cheaper to
revise and reproduce. Therefore, the CD provides ordinary persons—
who bring nothing more to their project except interest and perhaps
passion—the documentary tools to explore their own past without
being oppressed by the “master narratives” of elitist professional histo-
rians, or by the costs of coffee table books, or being intimidated by a
prospective visit to the archives or public library. The Cape archives,
by the way, are not only friendly, but among the best sourced and
inventoried archives in the world. Alternatively, the CD may also help
prepare the researcher for a trip to the archives. Up country and over-



6 From Diaspora to Diorama

seas researchers as well as teachers can also now have access to archival
documents, as can people who are physically challenged.

The Lodge Slave-lodgings, lunatic asylum, police station, prison and brothel: these
were some of the functions which the building at the entrance to the
Company’s Gardens at the top of Adderley Street (the old Heerengracht),
unashamedly fulfilled. The Lodge fused the dramatic themes of thraldom,
perpetual servitude, sex and insanity into a fortress of misery which could
provide South African novelists with the raw material of a hundred nov-
els. This complex building was a forgotten crucible of colonialism and
apartheid which helped perpetuate facets of colonial life which are still
recognisable in present-day South Africa. 

Contents of CD From Diaspora to Diorama contains over 9,000 pages of interpretations,
newly unearthed eyewitness accounts, newly commissioned aquarelles by
John English and many new sketches and photographs by model builder,
Peter Laponder; there are also appendices of 6,000 entries: slaves, political
exiles, slave voyages to the Lodge; slave cargo lists, Lodge censuses, Slave
Lodge deaths and Lodge manumissions, in short, this publication is the
most extensive single work on any one building and one community in
South Africa. The reader is directed to the section in this pamphlet con-
cerning indexes (page 40) and appendices (page 38). A bird’s eye view of
the contents is on the back cover.

Family history If users are interested in their own family history then this E-book and its
clickable indexes should help provide genealogical data to explore. It is
curious that the Lodge slaves are often better documented than the set-
tlers. But then they were property of a corporation. The people in the
Lodge were mere entities to the Dutch corporation, but to us and the
church—both persons and souls. But we must admit that it is through the
arid ledgers of the VOC that we know anything of them at all. 
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AN INTRODUCTION TO THE LODGE

Anthony Holiday

IntroductionEven a brief review of the
history of  the bui lding
which Robert Shell, and
others commemorate in
t h e s e  p a g e s  s h o u l d  b e
enough to convince anyone
that it is the thought of Sig-
mund Freud and Jung,
rather than that of K. Marx
and F. Engels, which pro-
vides the best framework for
understanding (insofar as
understanding in the scien-
tific sense is at all possible)
the  modern  h i s to r y  o f
South Africa.

For the edifice which we
used to sedately style “The
Cultural History Museum”,
with its prim collections of
old silver, antique clocks
and other furniture of a
more “gracious” age, once
performed startlingly differ-
ent functions. The window-
less walls of the original
structure served, not only to
imprison slaves, owned by

the Dutch East India Company, and lunatics, whose ravings may have
reached the ears of loiterers in what is now Parliament Lane, but also
to smother the lustful pantings of free citizens and visiting sailors, who

 Fig. 3: 1:~The interior of the cultural 
museum
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made use of the bodies of the slave-women, while their menfolk were out
emptying buckets of excrement into Table Bay Harbour.

Slave Lodge, 
brothel, lunatic-

prison

These were the original purposes which the building atop the Heeren-
gracht, at the entrance to Company’s Garden, raison d’etre for the very
existence of the “refreshment station” the Dutch had established at the
southern tip of the “dark continent”, unashamedly fulfilled. In so doing,
it fused the conceptual themes of servitude, sex and insanity and let them
trickle like a polluted stream into almost every facet of the form of life
which is present-day South Africa.

Transformation The most striking proof of this
is the fact that, after it had at
last been emptied of slaves in
1811, the building was almost
immediately transformed into
the seat of law-making and
law-giving at the Cape, hous-
ing the Cape Supreme Court
between 1815 and 1914 and
serving, between 1827 and
1844, as home, first to the
Advisory Council and subse-
quently the Legislative Coun-
cil which met in the record
room on the upper floor. If
this extraordinary transition
aroused no public outcry, if
legislators and learned judges
were content to situate the
ancient edifices of Roman-
Dutch law in such a setting, it
must surely have been because
t h e y  h a d  s o  t h o r o u g h l y
absorbed the concepts associ-
ated with slavery and its degra-
dations into their own lives

and modes of judgement that the significance of what they were doing in
choosing to work in such a place altogether escaped them. The symbolism
of the Slave Lodge did not strike them, because the evils of slavery, servil-

 Fig. 3: 2:~Supreme court imposed on 
slave lodge, 1812
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ity, sexual abuse and madness had so poisoned their being as to quite liter-
ally blind them to the meaning of symbols of that kind.

Symbol blind-
ness

Only the diagnosis of sym-
bol-blindness of this order
can do anything to eluci-
date the colonists’ failure
to recognise that their
choice of site would guar-
antee that their legislative
and judic ia l  ac t iv i t i e s
would be infected by a
slave-owning mentality for
the next 150 years or more.
Indeed, it was not until
1974 when the last vestige
of legi s lat ion,  direct ly
linked to the preservation
of slavery, the Masters and
Servants Act, offspring of
the Masters and Servants
Ordinance of 1841, was
erased from the Statute

Book. Who can doubt, moreover, that the spate of apartheid-era legisla-
tion-–one thinks especially of the Immorality Act which prohibited sexual
encounters between whites and persons of colour, the Group Areas Act,
which drove slave-descendants from homes some of them had inhabited
for generations and the Pass Laws, enabling the state to restrict the free-
dom of movement of the nation’s African majority to a degree unprece-
dented except by Hitler and Stalin—was connected to this same
blindness?

The philosophy 
of language of 

the Lodge

Now, what I have chosen to call “symbol-blindness” is not entirely (or
even chiefly) a psychological matter, although, doubtless psychological
considerations would have to enter in to any full blown discussion of it.
The topic seems to me, rather, to fall within the field of the philosophy of
language, embracing as it does the tandem concepts of understanding and
meaning. For the Slave Lodge to acquire a symbolic significance for the
Cape slave-owners and their descendants, there would have to have been
levels of understanding and meaning in the communications between

 Fig. 3: 3:~Colonists agitate against convict 
immigration
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owners and slaves which encompassed dimensions way beyond the lan-
guage of imperative utterance, threat and compliance. The semantic field
would have had to admit of the possibility of conversation taking place
between the parties, that is it would have to permit a communion, punc-
tuated by such silences as occur, not because the interlocutors have noth-
ing more to say to one another, but because what they have to say is
already so profoundly understood that there is no need for words. If com-
munication of that sort had become general between slave-owners and
slaves, the days of Cape slavery would have been rapidly numbered. For
conversation, as I have just described it, is possible—in the logical and not
merely in the psychological sense—if and only if the interlocutors are
present to one another as persons, as autonomous ethical subjects, each
recognising the autonomy of the other, in and through that very other-
ness.

Questions of 
definition

However, slavery is defined—and the question as to its correct definition
is the master-enigma students of the condition confront—the definition
must exclude the very idea of autonomy of this sort. Slaves are not auton-
omous beings. They are automatons, whose rational principle, as Aristotle
argued in Book One of his Politics, is vested, not in themselves, but in the
designs of their owners. As such, they cannot be expected to respond
appropriately to calls for sobriety in speech of the form: “Do you really
mean what you say?”, “Have you said what you truly think?”, “Does what
you say square with the fact that you are saying it?” Accordingly, the
speech of slaves will always be a “speech” from which it is conceptually
impossible to remove the snigger-quotes as long as the speakers are
regarded as one regards a slave, in much the same way as “computer-
speak” cannot be regarded as speech, properly so called. There can be no
attribution of depth to the language and life of a slave, just as there can be
no imputation of profundity to the life and language of a computer. And,
just as a building which once housed computers cannot serve as a memo-
rial to them after the machines have been removed, so a Lodge which was
once the dwelling place of slaves cannot symbolise the condition of slav-
ery, unless its previous inhabitants can be seen in a wholly different light.

A future transfor-
mation

From all this it follows that the work currently being undertaken by
archaeologists at the Cultural History Museum, together with seminal
scholarship, will, insofar as they succeed in transforming the building into
a symbol of slavery, constitute a kind of retrospective emancipation of its
original inhabitants. If it truly becomes a symbol, the former home of the
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DEIC’s slaves will serve as a device to remind us of what the slaves truly
were, communicants in our common humanity, whose integrity had been
violated by an inhumanity so evil that even today we can scarcely pene-
trate its meaning.

Unesco World 
Heritage site

The contributors’ greatest wish is to elevate the Lodge’s to World Herit-
age Site status. Nothing should stop this process.

Anthony Holiday, Tamboerskloof, September 2002
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A Guide to the Old Slave Lodge CD 15
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of Advanced Architectural Studies. His field of study is old Cape build-
ings and landscapes—and the people who made them.

Hans HeeseHans Heese is a well-known historian and best known genealogist of the
early Cape. He has contributed seminal interpretations in numerous arti-
cles. An early work, Groep sonder Grense is now translated into English
and on CD and several indispensable reference works in the field. He is
based at the University of Stellenbosch.

Tony HolidayAnthony Holiday, South African philosopher, journalist and anti-apart-
heid activist, taught philosophy at the University of the Western Cape. It
was there I met him and we soon established a firm friendship based on
Hegel and Slavery. Until he became ill, he wrote a widely read column in
the liberal daily, the Cape Times. His work was noted for independence of
thought and incisive analysis of life in the post-apartheid era.

Edward HudsonEdward Hudson is an independent historian living in Paris
and England. He has written several essays on Samuel [Euse-
bius] Hudson—the first South African diarist—and is cur-
rently working on Hudson's manuscripts (1796 to 1828).
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Mogamat “Kam-
mie” Kamedien

Mogamat “Kammie” Kamedien grew up and matriculated in the Eastern
Cape at Uitenhage Senior Secondary School, but graduated at the Univer-
sity of the Western Cape in the early 1980's in the social sciences. As a
former high school teacher on the Cape Flats, and as a career civil servant
in the public sector, his lifelong interest in our South African slave herit-
age led him to become a web contents developer to place the relatively
unknown chapter of South African slave history on the map of the digital
village. 

Peter Laponder Peter Laponder's interest in slavery at the
Cape started when working at Iziko Muse-
ums in Cape Town as an exhibition designer/
model maker. After extensive research into
the Dutch East India Company Slave Lodge,
he constructed the model now on display in gallery four of the old Slave
Lodge.

Margaret Lenta Margaret Lenta, was emeritus professor and senior research associate at
the University of KwaZulu-Natal. In 1999 she was co-editor of The Cape
Diaries of Lady Anne Barnard, 1799-1800, and in 2006 she published an
abridgement of these diaries entitled Paradise, the Castle and the Vineyard.
Sadly, Margaret died of cancer on 5 November 2012.

Blair Linen 
Demers

Blair Linen Demers graduated from Princeton University in 1996 with a
BA Honours in History and a concentration in African Studies. She wrote
a distinguished thesis on Malagasy women and the Cape. She now lives in
Portsmouth, New Hampshire, with her husband and their two girls,
Schuyler and Zoe, and works as a non-profit consultant.

Jackie Loos Jackie Loos is a researcher who writes about nineteenth century Cape
slaves and other members of the labouring classes. Her book Echoes of
Slavery appeared in 2004, and some of her stories have been used in the-
atrical presentations. Her weekly column in the Cape Argus is widely read
and anticipated.

Antonia Malan Antonia Malan is a leading historical archaeologist in the Historical
Archaeology Research Group, University of Cape Town, and has pub-
lished extensively on material culture, gender and identity in the eight-
eenth century Cape Colony. She has initiated an international
transcription project of the Cape Resolutions of the Political Council and
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the Cape estate inventories which are available both online (TANAP) and
on two CDs.

James RavelJames Ravell was born on September 12, 1935. He died in Johannesburg
on March 25, 1994. He returned to South Africa at the end of January
1994 to assist with voter education, working for the Ben Turok Institute.
The institute was engaged in the preparations for the first democratic
elections in South Africa in 1994 when he died. He had several publica-
tions among which is A select bibliography of the Cape-Madagascan slave
trade, 1652-1795. He is survived by his widow, Thelma Pinto [in photo]
and two sons, Rayner Ravell and Mondli Ravell.

Robert RossRobert Ross is Professor of African History at Leiden University in the
Netherlands, and has written several books and more than a hundred arti-
cles on the history of the Cape Colony in the eighteenth and nineteenth
centuries, and more widely on the history of South Africa.

Sandra Rowoldt 
Shell

Sandra Rowoldt Shell headed the Cory Library for Historical Research
for many years and, from 2004-2011, was head of the African Studies
Library at the University of Cape Town. She has a Masters degree in His-
tory from the University of Cape Town on the Rev. James Laing and mis-
sion history in the Eastern Cape, and a doctorate on the Ethipian Oromo
slave children at Lovedale.

Christopher C. 
Saunders

Christopher Saunders is Professor Emeritus in the Department of His-
torical Studies, University of Cape Town. He has written widely on prize
slaves, southern African history and historiography. In South Africa, he is
regarded as the historian’s historian.

Robert ShellRobert C.-H. Shell is Extraordinary Professor of Historical
Demography in the Statistics Department, University of the
Western Cape. Rob has written on slavery, Islam and AIDS
and lives in Cape Town, South Africa. His book on Cape slav-
ery, Children of Bondage (1994) is still in print.
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A. Van Rensburg André Van Rensburg is Senior Pastor of Springwood Seventh-day
Adventist church in Brisbane, Australia. André is a freelance historian and
researches Cape slavery and Cape Islam. 

Kerry Ward Kerry Ward is assistant professor of world history at Rice University in
Texas. Her book is titled Imperial Networks: Free and forced migration in
the Dutch East India Company. She has published widely in the areas of
South African, Southeast Asian and Indian Ocean history.

Piet Westra Piet Westra is the former director of the South Afri-
can National Library and has written many articles
and books on the early Cape. His most recent work is
an outstanding, archivally based study on the Meer-
min revolt, co-authored with Dan Sleigh, entitled The
taking of the slaver Meermin, 1766 which has also been
published in Afrikaans and Dutch. He has recently
received the Dutch Royal distinction of Ridder
(Knight) Order of Oranje-Nassau, for exceptional ser-
vices to the community.

Nigel Worden Nigel Worden has been at the forefront of the histo-
riographical revolution of slave studies in South Africa.
He has produced several books and many anthologies
on slavery and the abolition period and has also writ-
ten more broadly, on South African history. He is
based at the University of Cape Town where he has
many graduate students. A recent anthology is Cape
Town between East and West published by Jacana
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A NOTE ON ARTWORK BY JOHN ENGLISH

Victor de Kock’s, 
Those in Bondage

Many historians still draw their mental images of Cape slavery from
Victor de Kock’s, Those in Bondage published in 1950 and thereafter
reprinted. For example, in depicting the seizure of slaves in Madagas-
car, European males are seen on the right with drawn cutlasses chasing
a black mother and child from a burning village. The home, judging
from the intensity of the light from the door of the hut, has also been
set alight.

 

 Fig. 5: 1:~Victor de Kock’s choice of picture for the slave trade

I found that such pictures (mostly unreferenced) do not capture the
reality of the slave trade, most especially with regard to the slave trade
to the Lodge. 

I therefore provided a professional artist, John English, with all the
archival and documentary sources needed to illustrate a Cape slave’s
life. Every element in his drawings is sourced. For example, for the
aquarelle, “Slave Trading at Tulear,” we used the log of the voyage of
the Leijdsman (included in the text of the CD). The finished picture
was intended as a counterpoint to the grisly drawing above.
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 Fig. 5: 2:~Mapping the archival assets
see following signature

Monday 16 September 1715 

“We again sought an audience with the king 
and after we had sat with him for a while, 
a crocodile head was brought to him by one of his couriers, 
who was received and treated very amicably, 
which is something he seldom did for his subjects 
when they carry out such an act of heroism as killing a crocodile.”

Saturday 27 July 1715...
“As a token of friendship, 
we should approach him 
beating our drums 
and sounding our trumpets. 
As we did not have these with us, 
we sent a letter to the captain
 to inform him of the king’s wish.
 The instruments
 [consisting of one drum, 
one trumpet, one violin and 
two flutes, 
with which he was welcomed 
at about 4 o’clock in the 
afternoon] were immediately 
sent to us and we proceeded 
  in the name 
  of the Honourable 
  Company 
  toward his majesty, 
  whom we found sitting 
  under a large 
  tamarisk tree 
  accompanied by 
  4 to  500 men 
and women, all, except 
the women, armed with muskets 
and lances.”

The Leijdsman
drawn 
from a sketch
in the 
Cape Archives

Shadows at  four o’ clock

Under the tamarisk tree
“We had the brown noblemen asked 
to announce our arrival in Feringe to the
king, to which they acceded and we were taken 
to a native village where we were to await a reply. 
We stayed there with an old chieftain 
who treated us with sweet potatoes and milk. 
When the messengers returned they told us: 
the king is now close by and intends to await 
your arrival in the shade of a thick tamarisk tree.”

John English’s first tasks were 
(1) to plan the composition
(2) to sketch the cartoon (below) 
(3) to map the following archival assets to the cartoon:~

(4) Finally, John English added colour:~
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 Fig. 6: 1:~Slave trading, Tuléar, Madagascar, 1715

 Fig. 6: 2:~The taking of the Meermin, 1766



24 John English, 1922 to 2013

 Fig. 6: 3:~Lady Anne identifies shaven slaves as “Etruscan pots”

 Fig. 6: 4:~Inbound Company slaves recuperate in hospital, 1699
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 Fig. 6: 5:~Jan Smiesing’s Lodge school for boys, circa 1723

 Fig. 6: 6:~Michele Thibault enters the Lodge, 1806



26 John English, 1922 to 2013

 Fig. 6: 7:~Chinese convicts escape using human pyramid, 1705

 Fig. 6: 8:~Foraging Lodge slaves caught by ratelwag, 1735
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MENDING AN ERA

UNESCO spon-
sored

The compiler and fellow contributors have
outlined a comprehensive set of ideas in this
UNESCO commissioned and sponsored
study for the identification and creation of a
public memorial of the slave trade to south-
ern Africa and more generally, slavery in the
region. The intention of the contributors is

to create an atmosphere of local and international public interest so
strong that the Slave Lodge in Cape Town may in time become a
UNESCO world heritage site and the central symbol and memorial of
slavery in South Africa. The collection of documents and secondary
articles are all housed on a CD which are comprehensively indexed
and cross referenced in a full colour, rich media .pdf file. The CD con-
tains 12 volumes, each of which pertains to a particular phase of a
Cape slave’s life and slavery at the Cape. Indexes and appendices are
included and comprise two further volumes. Abstracts of these twelve
volumes are found on the following ten pages.

 Fig. 7: 1:~The orientation page of the CD
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Volume 1:~First 
passage and 

other chapters

The Lodge in bondage
Number of chapters:~11

Page range:~1 to 305

The single chapter on the first passage should not make a reader con-
clude that the topic was unimportant. The first passage is the least docu-
mented aspect of the slave trade, not the least important. There are few
sources. This is the main reason there is so little primary information and
scant secondary literature. The topic has been obscured by the well-docu-
mented Atlantic middle passage on which the prolific abolitionists delib-
erated in the nineteenth century. Capture and the first passage were the
most traumatic aspects of the peculiar institution and cast a dark shadow
over the rest of the enslaved person’s life.

 Fig. 7: 2:~Billy King’s sketch of the first passage
Artist: Billy King
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Volume 2:~The 
middle passage

The middle passage
Number of chapters:~12

Page range:~306 to 1677

The trip by sea to Cape Town,
resistance on the ships and mortal-
ity. The bulk of the primary docu-
ments concern the middle passage
which fulfils the remit from UNE-
SCO slave trade route project.
These documents consist of edited
slaving journals, such as the Voor-
hout, Soldaat, Leijdsman, Jagtrust
and the Zon. These chapters also
include interpretations of the slave

trade by André van Rensburg, Andrew Alexander and James Ravel. Two
chapters deal with the documentary sources of the slave trade.

 Fig. 7: 3:~Below decks on the HMS Albany
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Volume 
3:~Arrival and 
Recuperation

Recuperation in the Company hospital
Number of chapters:~2

Page range:~1678 to 1703

This volume deals with the arrival, acclimatisation, mortality and psy-
chological incorporation of the new arrivals (nuwelings) into the Lodge.
This phase of an imported slave’s life is new to the slave literature.

 Fig. 7: 4:~DRC church on left, hospital on right
E.V. Stade, 1710

The hospital could house 600 patients and was specialised to deal with a
number of conditions. By all accounts it was one of the most successful of
all VOC institutions at the Cape.

The hospital employed 
approximately 30 slaves, for 
nursing and also for porter-
ing sick seamen to the hos-
pital from the ships. A slave 
burial detail met at noon 
everyday to convey cadavers 
to their resting place.

 Fig. 7: 5:~Layout of the hospital
Artist: Peter Laponder
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Volume 
4:~Eyewitness 

Accounts

Contemporary accounts
Number of chapters:~25

Page range:~1704 to 2033

Descriptions of the Slave Lodge by slaves, administrators and travellers,
each of whom had their own virtues and biases. Eyewitnesses of the Lodge
itself were far and few between since travellers and burghers and adminis-
trators all avoided the shameful and stinking Lodge. Nevertheless there
were many eyewitness accounts, mostly from English and German-speak-
ers.

 Fig. 7: 6:~Mentzel’s Lodge
Artist: Peter Laponder

 Fig. 7: 7:~Thibault’s Lodge, 1786



32 From Diaspora to Diorama

Volume 
5:~Biographies

Biographies of individual slaves.
Number of chapters:~5

Page range:~2034 to 2214

There was sufficient primary material to create biographical portraits of
some VOC slaves and convicts. One of these portraits, Petronella Lam-
mertsz was purposefully created from primary material on the CD.

 Fig. 7: 8:~Een Toepas ofte Mardijker met Sijn Vrouw
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Volume 
6:~Architecture

An architectural history of the Lodge
Number of chapters:~3

Page range:~2215 to 2375

Many authors have written on the Lodge as an architectural icon, for
example, as representing Michel Thibault’s “best work.” The volume tries
to get to the structure and function of the building.

 

 Fig. 7: 9:~Suggested demolition of the Lodge in 1955
Bronkhorst Report
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Volume 7:~Inter-
pretations

Secondary interpretations of the Lodge
Number of chapters:~7

Page range:~2376 to 2884

Considerable secondary interpretations exist which have dealt with the
Lodge. Ockert Geyser’s work in Afrikaans and English is still the most
intensively archivally based interpretation.

 Fig. 7: 10:~The staff and cart of the old post office

The Cape Trian-
gular

One of the first public offices to open in the old Lodge building was the
Post Office. One of the most valuable stamps in the world, the Cape tri-
angular, designed by Charles Bell, was sold here.
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Volume 8:~His-
torical Archaeol-

ogy

Articles on historical archaeology
Number of chapters:~3

Page range:~2885 to 3060

A part of this UNESCO grant went to a full-scale historical archaeologi-
cal dig by Dr Gabeba Abrahams and others.

 Fig. 7: 11:~The controversial painted lady

 Fig. 7: 12:~From Gabeba Abrahams-Willis’ Report on the Lodge
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Volume 
9:~Museology

Museology of the Slave Lodge
Number of chapters: 2

Page range:~3061 to 3387

Two recent theses deal with the Iziko museology of the Lodge.

 Fig. 7: 13:~The Lodge lit up as part of festivities
The column of light
One of the outstanding exhibits of the Lodge is the 
column of light neatly set in an original alcove of the 
building which contains lists of slaves’ names embed-
ded in drums of clear resin which the viewer can touch 
and turn, akin to a secular Buddhist prayer wheel.

 Fig. 7: 14:~The banner of the exhibition
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Volume 
10:~Appendices

Appendices
Number of sections:~6 of 6

Page range:~3388 to 7139 see appendices table, “Sections of Appendi-
ces” on page 38.
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Volume 11: 
Appendices

Sections of Appendices

TABLE 1. Sections of Appendices

Section
Total 
pages

Start

Finish

C
hapters Description

Cargoes 662 1 662 4 Lists all known cargoes to 
Lodge where individuals 
are named on the cargo 
manifest or journal of the 
voyage

Voyages 357 663 1019 35 Lists all known voyages 
and various annotations 
and details from primary 
sources

Baptisms 244 1020 1263 1 Transcription of com-
pany Lodge baptisms

Censuses 855 1264 2118 6 Transcription of com-
pany Lodge censuses

Death notices 1286 2119 3404 Transcription of com-
pany Lodge deaths

Manumissions 297 3405 3752 1 Transcription & partial 
annotation of company 
Lodge manumissions
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Bibliographies of 
Bondage

Volume 11:~an updated Bibliographies of Bondage

Number of sections:~6 of 6

Page range:~7140 to 7702
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Indexes Volume 12:~The indexes and lists

Number of sections:~11

Page range:~7703 to 9385

The indexes are described in the following table:~

TABLE 2. The structure and function of the indexes

Index name Purpose Pages Comments
Archivalia References 7703 to 7781 This provides a clickable refer-

ence to every archival source used 
in the various chapters through-
out the CD. 

Authors Bibliographical 7782 to 7920 Index to all authors, artists, trans-
lators and editors mentioned in 
all texts on the CD.

Contributors Listing and mini 
biographies

In this pam-
phlet, see 
“Details of 
contributors” 
on page 14

The list of contributors contains 
biographical and professional 
details of the contributors to this 
CD.

Glossary Terminological 
and contextual

8247 to 8288 This index contains explanations 
of exotic terms, details of cur-
rency and so on
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Personalia identity: all per-
sons who were 
connected to the 
Lodge

8289 to 9003 The personalia index is not stand-
ardised by name, but it is full. 
Spellings vary across all names 
and over time. It would violate 
the archival record to standardise. 
The key was to respect des fonds—
respect the sources. 

Places Geographical, 
details locations 
based on dates

9004 to 9125 Here are listed all archipelagos, 
batteries, bays, blocks, buildings, 
capes, countries, gates, farms, 
fountains, houses, islands, lanes, 
libraries, places, museums, neg-
erijs, ports, prazos, pumps, 
regions, rooms, rivers, stations, 
streets, suburbs, taverns, territo-
ries, valleys, villages. The com-
piler did not standardise the 
spelling of place names as these 
varied from document to docu-
ment. Many of them have never 
been satisfactorily identified. 
Each place name in the index is 
followed by its contextual date.

Ships Names of vessels 
only

9126 to 9162 This index includes only ship 
names. Types of ships, e.g. “flute” 
are found in the subject index. 
Parts of ships, e.g. “consta-
pelkamer” are found in the subject 
index, but may also be found in 
the glossary, if technical. Entries 
arranged by date.

TABLE 2. The structure and function of the indexes (continued)

Index name Purpose Pages Comments
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Subjects Details subjects 
based on dates

9163 to 9362 The subject index should be most 
useful as many of the sub-entry 
headings are arranged themati-
cally and then by date. Thus his-
torical documents are arranged 
under “Sources.” Others include: 
“Occupations,” “Trade items,” 
etc. The third level of the index is 
date. There are many foreign 
terms which are more fully 
explained in the separate glos-
sary, which includes a page refer-
ence for context.

Timeline Timeline 9363 to 9392 Germane events affecting the 
Cape and its slave system

Timetable Day schedule 9393 to 9395 This lists all known time sched-
ules for the Lodge slaves, whether 
on board a slaver, inside the 
Lodge or in the hospital.

Titles Bibliographical 7921 to 8246 This index to titles, half titles and 
subtitles includes most impor-
tant works in all text, boxes, cap-
tions and footnotes as well as in 
the bibliography. Definite and 
indefinite articles in all languages 
have been retained. Thus, the 
title The Aardvark lists under The 
Aardvark not under Aardvark. 
The Afrikaans “‘n” has been 
replaced with “Een”. All items 
here are clickable on the page 
number following the “dot 
leader”.

TABLE 2. The structure and function of the indexes (continued)

Index name Purpose Pages Comments
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REVIEWS...

“Facing up to slavery...”

Bryan Rostron

IntroductionThe most conspicuous, vibrant heritage of Cape Town—one you can
see in faces all around you in any street—is still the one we most avoid:
slavery. Cape Town remains firmly in denial. For a hundred and eighty
years this was, legally, a slave society, with slaves in the majority for
much of that time. Today, however, the city’s founding inheritance
skulks in the background, shrouded in embarrassment and amnesia for
descendants of both masters and slaves. 

No monuments 
to slavery

 Fig. 8: 1:~The indecipherable commemoration plaque
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Even the plaque in Spin Street, commemorating the tree under which
slaves were auctioned, is so inconspicuous that most pass by without a
glance. But at last, at the nearby Slave Lodge, this shuffling silence is
beginning, hesitantly, to be broken.

A new exhibition A new exhibition begins to tell the story of slavery at the Cape. Yet this
also seems to be a victim of the city’s ambivalent attitudes. The display
opened in May with little publicity, and of the two times I have visited,
once there were three other people and last week five others, mostly for-
eign tourists. For locals, it is as though an invisible veil of shame still cov-
ers this subject.

Inexpensive CD 
on the Lodge

Now, opportunely, comes the publication of a low-cost CD, a magnifi-
cent resource, that contains everything any member of the public might
want to know about slavery at the Cape, and specifically the Slave Lodge.
Divided into easily digestible sections, the CD contains clearly-written
chapters by leading historians, with illustrations, plus over five hundred
pages of slave names, identifications and dates, to help those interested in
tracing their own ancestry. It is both scholarly and popular, removing any
lingering excuse for evasion over slavery. The cost, less than half that of
books a third of the size, is R70. The compiler Professor Robert Shell says:
“I am most concerned to place high quality, non esoteric research into the
Cape Flats homes. In this way people may be able to work out their own
identity without recourse to overly academic and expensive works.”

Unesco world 
heritage site 

This unique project is part of a campaign to have the Slave Lodge
declared a UNESCO World Heritage Site. The Lodge, the handsome
cream-coloured building at the top of Adderley Street, looked very differ-
ent when built to house Dutch East India Company slaves, a status one
historian defined as, “the socially dead.” Robert Shell, author of the 1994
masterpiece on Cape slavery, Children of Bondage, explains in his conclud-
ing chapter, “With none of its inhabitants able to see out and with no one
able to see in, it could, in a sense, be ignored, even though it was based on
Cape Town’s busiest thoroughfare, in the centre of town, a shameless for-
tress of human misery.”

Slaves were crammed in like livestock. The only Euro-
peans in the Lodge were lunatics and criminals ….
Between eight and nine o’ clock in the evening, the
Lodge was, however, visited by settlers and sailors as a
brothel. 
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The redemption 
of the building 

after 1808

After ceasing to be a Slave Lodge in 1808, the building became govern-
ment offices, accommodating the Attorney-General, the Receiver of Reve-
nue, the Post Office and Public Library. In 1815 (until 1914) it served as
the Supreme Court, apparently with no sense of irony, as well as the colo-
nial Advisory Council and then Legislative Council. Thus Cape Town
effectively covered over the Lodge’s grim past, which has remained largely
overlooked till now.

Introductory 
video

The new exhibition at the Lodge is only a start. It comprises several
rooms, with an informative video, accounts of the life and conditions at
the Lodge, details of the infernal slave trade, mostly from the Indian
Ocean basin, as well as descriptions of the extraordinary cultural and lin-
guistic diversity that this concentrated in the Cape.

Running on 
empty 

Then, suddenly, the exhibition stops. The money ran out. This high-
lights the fact that while there’s cash for sports stadiums or departmental
cocktail parties, our politicians economize on “memory”, despite lip ser-
vice to learning from the past. Instead, on the second floor, there is a hap-
hazard collection of antique jewellery, silverware, clocks and Victorian
glass. It is a sloppy presentation, with no thread or cohesion, and presents
a jarring, even insulting, contrast to the slave exhibition downstairs. What
on earth is this hodgepodge of settler memorabilia still doing here? The
only other appropriate rooms are those housing the “Breaking the
Silence” show of paintings and banners from women of the Khulumani
Support Group, telling of their experiences under apartheid, and the
“Separate is not Equal” exhibition about the fight in the U.S.A. for racial
de-segregation in schools. The Slave Lodge still feels like a space that has
been only half liberated.

Anne Eichmann’s 
thesis

In the new CD, From Diaspora to Diorama, one of the most fascinating
sections is, “Representing Slavery in South Africa” by Anne Eichmann,
which analyses the strange history of the Slave Lodge as a museum and
gives an intelligent account of behind-the-scenes clashes as to how the
current exhibition should be presented. This debate became quite heated.
Anne Eichmann writes, “representing slavery was deeply entangled in
controversial identity politics.” Some felt it should highlight “coloured”
heritage and identity, while others claimed it should encompass a wider
story, embracing ideas of national reconciliation and a culture of human
rights. 
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Disagreements 
over the narra-

tives

There were also fierce disagreements on the narrative, with some saying
the original script portrayed slaves only as passive victims. Anne Eich-
mann concludes, “The result of this controversy is a text that clearly
evades a story of victimization and tries to convey a more balanced and
more complex picture of slavery.” My question, however, is why are such
contrasting views excluded from the exhibition itself? History is not a set
of facts laid down by committee, but something that is constantly chal-
lenged and reassessed. The curators should take the public into their
confidence and allow us to become part of this work in progress.

In his recent book on the British struggle to abolish slavery, Bury the
Chains, author Adam Hochschild writes of the advent of emancipation in
1838: How, then, was it to be celebrated? As a historic, pioneering mobi-
lization of public opinion, via boycotts, petitions, and great popular cam-
paigns, all powerfully reinforced by the armed slave revolts? Or as a great
gift to poor slaves by a group of pious, benevolent men?

A battle of mem-
ory 

In this battle of memory, the “pious” benefactor faction held sway for
over a century before the pendulum of interpretation swung dramatically
in the other direction. As Hochschild records, from downtrodden mill
workers to the suffragettes, “Again and again, agitation for domestic
reform of all sorts drew on the antislavery movement as a tactical model
and on slavery itself as a powerful metaphor.”

Thoroughness of 
the CD

The impressive aspect of the new CD on the Slave Lodge is that it is so
thorough. There are sections on the various stages of the slave trade,
reports of particular voyages, eyewitness accounts, plus the stories of sev-
eral slaves. Sandra Rowoldt Shell shows how she traced the genealogy of
one slave woman, Petronella Lambertz, while Jackie Loos reveals that
General Louis Botha, first Prime Minister of the Union of South Africa,
was a descendant of a slave from India, Groote Catrijn.

A vast, complex 
business-system

Slavery was a vast, complex business-system, driven with corporate-like
logic and ruthlessness. Robert Shell remarks in his conclusion: “Our col-
lective memories are so short that we have forgotten we have already been
globalised once before.” Echoes of slavery are everywhere in Cape Town,
yet still barely seen. That reticent plaque in Spin Street, for example:
60,000 humans may have been sold here alone. And while the Slave
Lodge itself has finally begun a process to recover the memory of our bru-
tal past, it remains a cautious, under-funded start. As the From Diaspora to
Diorama CD concludes: the complete development of the Slave Lodge
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would potentially gain not only World Heritage status, it would also
attract attention internationally and locally … “but most importantly
from the local descendants of owners and slaves, enabling them to under-
stand their common heritage.” 

“...an important achievement...”

Shamil Jeppie, University of Cape Town

“From Diaspora to Diorama is an important achievement that will be val-
ued very widely as an educational instrument, as a source of important
historical information and possibly even just as 'edutainment'! It is a mine
of primary source material and an array of impressive scholarly articles
relating to slavery and in particular the Slave Lodge'. It is very user-
friendly. The CD reflects, as usual, the compiler's passion for his subject
and the meticulous care with which he gathers his data. This type of
labour of love has always been an inspiration and a source of fascination.
This resource is possibly the first such instrument in the country and it
should be made available to students and researchers from high-school
through university level and anybody elsewhere concerned with our past.”

“...Offers much more than the title suggests”

Cornelius Thomas, Rhodes University

“Professor Rob Shell’s CD, From Diaspora to Diorama: The Old Slave
Lodge in Cape Town, offers much more than the title promises. It resusci-
tates the memory of slavery over the ages; it offers a modern archive of
one of the oldest human institutions, and indeed one that has suffused
South African society for well over three centuries. The memory of slavery
has been excised from our national conversation–as if it never existed and
as if it had no impact on our society. Yet the mores of our society, the
expected and offered deference and our language (maids and madams; die
baas en die tuinjong) remain real, albeit now sanitized by political correct-
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ness, and stem from our social relations produced in a slave society. This
E-book challenges the South African public, academia, the media and
government to honesty about how long the liberation struggle was waged,
by whom and where; it implicitly argues that the long memory of our his-
torical experience needs to be resuscitated and integrated into our histori-
cal discourse, in public conversation.”


